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Implementasi Proximity sebagai Trigger pada Pengangkat Roda Kereta Semi Otomatis 

Berpenggerak Dongkrak Elektrik 

 

Abstrak 

 

Kereta api merupakan salah satu sarana transportasi jarak jauh yang digunakan 

oleh masyarakat Indonesia. Kereta api dilakukan perawatan terutama di bagian roda 

kereta. Peralatan perawatan roda yang tersedia di UPT Balai Yasa Manggarai milik PT. 

Kereta Api Indonsesia (Persero): (1) crane sebagai pemindah/perubah posisi wheel-set (1 

set roda kereta yang sudah dilepas dari kereta/gerbong) di workshop, (2) alat konvensional 

berupa dongkrak hidraulik dan bearing sebagai pengangkat, pemutar, dan penurun wheel-

set. Keterbatasan jumlah crane (hanya 1 unit) walaupun di-support dengan dongkrak 

hidraulik perawatan wheel-set masih terkendala. Waktu pengerjaan (pengangkatan, 

pemutaran dan penurunan masih memerlukan ± 22 menit/1 wheel-set. Sementara jumlah 

wheel-set yang melakukan perawatan setiap hari kerja ± 24unit atau = ±8 jam kerja. 

Sehingga antrian wheel-set hampir terlihat setiap hari akibat waktu perawatan yang 

relative hampir satu hari. Berdasarkan permasalahan tersebut memerlukan solusi dengan 

membuat alat pengangkat, pemutar dan penurun roda kereta semi otomatis. sensor 

proximity infrared sebagai data input yang diproses oleh mikrokontroler arduino uno. 

Hasil proses tersebut akan mentrigger dongkrak elektrik berhenti bekerja apabila sensor 

mendeteksi wheel-set kereta kemudian LED dan buzzer akan aktif sebagai indikator. 

 

Kata kunci: dongkrak elektrik, wheel-set, proximity infrared, arduino uno, LED, Buzzer 

  



 

ix 
 

Implementation of Proximity as a Trigger on Electric Jack Driven Semi-

Automatic Train Wheel Lift 

 

Abstract 

 

Train is one of the means of long-distance transportation used by the people of 

Indonesia. Trains are carried out maintenance, especially on the wheels of the train. Wheel 

maintenance equipment available at UPT Balai Yasa Manggarai owned by PT. Kereta Api 

Indonsesia (Persero): (1) crane as a shifter/change wheel-set position (1 set of train wheels 

that have been removed from the train/carriage) in the workshop, (2) conventional tools in 

the form of hydraulic jacks and bearings as lifters, players, and wheel-set lowering. The 

limited number of cranes (only 1 unit) even though they are supported by hydraulic jacks, 

the wheel-set maintenance is still a problem. Processing time (lifting, turning and lowering 

still requires ± 22 minutes/1 wheel-set. Meanwhile, the number of wheel-sets that perform 

maintenance every working day is ± 24 units or = ±8 working hours. So that wheel-set 

queues are almost visible every day due to time maintenance is relatively almost a day. 

Based on these problems, a solution is needed by making a semi-automatic lifting, turning 

and lowering device for the train wheel. Proximity infrared sensor as input data which is 

processed by the Arduino Uno microcontroller. The result of this process will trigger the 

electric jack to stop working when the sensor detects it. wheel-set train then LED and 

buzzer will be active as an indicator. 

Keywords: electric jack, wheel-set, proximity infrared, arduino uno, LED, buzzer  
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BAB I 

PENDAHULUAN 

 

 

1.1 Latar Belakang 

Kereta api merupakan salah satu sarana transportasi jarak jauh yang digunakan 

oleh masyarakat Indonesia. Kereta api dilakukan perawatan setiap periode tertentu. 

Perawatan kereta dilakukan untuk memperpanjang usia pakai, menekan gangguan, 

menjaga sarana, dan menekan biaya operasi. Kereta Api dilakukan perawatan terutama 

di bagian roda kereta. Salah satu dari serangkaian proses perawatan roda kereta api 

termasuk pelepasan roda dari as, pelepasan bearing kereta, penggantian bearing kereta, 

pembubutan roda, dan lain-lain.  

Peralatan perawatan roda yang tersedia di UPT Balai Yasa Manggarai milik PT. 

Kereta Api Indonsesia (Persero): (1) crane sebagai pemindah/perubah posisi wheel-set 

(set roda kereta yang sudah dilepas dari kereta/gerbong) di workshop, (2) alat 

konvensional berupa dongkrak hidraulik dan bearing sebagai pengangkat, pemutar, 

dan penurun wheel-set. Proses pelepasan bearing dari as roda dengan cara melepas sisi 

satu dan sisi yang lain (Gambar 1.1). Setelah satu sisi bearing kereta terlepas, wheel-

set akan diangkat kemudian diputar 1800 dengan dongkrak hidraulik dan bearing. 

 

Gambar 1.1 Proses Pelepasan Bearing 
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Penggunaan dongkrak hidraulik masih berbantuan tenaga teknisi untuk 

mengungkit agar wheel-set terangkat oleh dongkrak. Selanjutnya memilah wheel-set 

yang masih layak dengan yang perlu perawatan. Wheel-set harus diangkat (seberat ±1,5 

ton) dan diputar 900 oleh teknisi untuk dipindahkan pembubutan (Gambar 1.2). 

 

Gambar 1.2. Proses Pemisahan Wheel-Set 

Saat ini dongkrak sudah dimodifikasi dengan penambahan hidraulik, namun 

tidak berpengaruh signifikan menggantikan peran crane. Keterbatasan jumlah crane 

(hanya 1 unit) walaupun di-support dengan dongkrak hidraulik perawatan wheel-set 

masih terkendala. Waktu pengerjaan (pengangkatan, pemutaran dan penurunan masih 

memerlukan ± 22 menit/1 wheel-set. Sementara jumlah wheel-set yang melakukan 

perawatan setiap hari kerja ± 24unit atau = ±8 jam kerja. Sehingga antrian wheel-set 

hampir terlihat setiap hari akibat waktu perawatan yang relative hampir satu hari 

(relative lama) (Gambar 1.3). 
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Gambar 1.3 Antrian Roda di Bagian LOS Roda 

 

Sensor proximity infrared (Imasura, Miko Rizal, R.A Suwodjo Kusumoputro dan 

Mohammad Fathoni. 2016) mendeteksi suatu objek pada jarak tertentu dengan 

memanfaatkan sifat cahaya. Sinyal input infrared dari transmitter membentur benda 

dan gerlombangya memantul kembali ke receiver (Yunardi, Riky Tri, Winarno, 

Pujiyanto. 2017). Sinyal ini di-input ke Mikrokontroler Arduino Uno melalui port input 

dan output. Intruksi pergerakan motor dari mikrokontroler sesuai data input yang 

masuk (Dharma, Lingga I Putu, Salmawaty Tansa dan Iskandar Zulkarnain Nasibu. 

2019). Modul driver BTS 7960 sebagai pengendali yang akan mengaktifkan motor 

pada dongkrak elektrik sesuai input dari mikrokontroler Arduino Uno dengan 

maksimal keluaran arus hingga 43A (Kartika, dkk. 2019). Dongkrak elektrik mengubah 

energi elektromagnetik menjadi energi kinetik dan menghasilkan tenaga gerak lurus 

(Setyawan, Lukas B., Gunawan Dewantoro, dan Anggoro Agung Pambudi. 2016). 

Pergerakan dongkrak elektrik diatur oleh sensor proximity infrared. 

Berdasarkan permasalahan keterbatasan crane dan dongkrak hidraulik yang 

belum optimal fungsinya untuk perawatan roda memerlukan solusi, yaitu dengan 

merancang sistem semi otomatis. Sistem terdiri dari hardware; alat pengangkat, 

pemutar, dan penurun wheel-set. Dimensi alat (p x l x t=75 x 50 x 161 cm), bahan dari 

plat besi. Selain itu terdapat 1 box panel berisi komponen dan modul dan 1 kotak casing 

yang terbuat dari plat besi; box panel memuat mikrokontroler Arduino Uno, modul 

driver BTS 7960, relay dan modul bluetooth (HC-05), dimensi (p x l x t=30 x 20 x 12) 

cm. kotak casing hanya berisi sensor proximity infrared, dimensi (p x l x t= 10x10x10) 



4 
 

Politeknik Negeri Jakarta 

cm yang diletakan pada bagian depan dari alas plat besi dongkrak elektrik. Instruksi 

kerja alat menggunakan software ArduinoIDE dan berbasis Android sebagai user 

interface. Komunikasi antara alat dengan android menggunakan modul bluetooth HC-

05. Pengangkatan, pemutaran dan penurunan roda kereta menggunakan 1 buah 

dongkrak elektrik dengan 2 buah sensor proximity infrared. Terealisasinya alat 

pengangkat dan penurun yang terintegrasi ke android, harapannya perawatan 

maintenance wheel-set bisa dilakukan lebih cepat. 

1.2 Perumusan Masalah 

a. Rancangbangun pengangkat, pemutar dan penurunan roda kereta semi otomatis 

b. Instalasi sensor proximity infrared dan dongkrak elektrik di pengangkat roda 

kereta semi otomatis 

c. Uji sensor proximity infrared mendeteksi roda kereta untuk trigger dongkrak 

elektrik 

1.3 Tujuan  

Adapun tujuan pembuatan alat adalah: 

1) Mengganti metode pengangkatan, pemutaran dan penurunan wheel-set 

dengan crane secara semi otomatis 

2) Menimplementasikan sensor proximity infrared sebagai trigger pada 

pengangkat, pemutar, dan penurunan wheel-set kereta semi otomatis 

3) Menguji mekanik dan elektrik pengangkat, pemutaran dan penurunan wheel-

set kereta dengan beban ± 1.5 ton 

1.4 Luaran 

a. Bagi Lembaga Industri 

1) Rancangbangun sistem semi otomatis pengangkat roda kereta terintegrasi 

android 

b. Bagi Mahasiswa 

1) Laporan Tugas Akhir 

2) Hak cipta alat 

3) Draft/artikel ilmiah untuk publikasi Seminar Nasional Teknik Elektro 

PNJ/Jurnal Nasional Politeknologi
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BAB III 

PERENCANAAN DAN REALISASI 

 

 

3.1 Rancangan Alat 

Implementasi Sensor Proximity pada Sistem Otomasi Pengangkat Roda Kereta 

Terintgrasi di Android ini digunakan untuk mengangkat wheel-set kereta secara semi 

otomatis dan memutarnya secara manual oleh teknisi dengan bantuan bearing pada 

bagian bawah alat yang bertujuan untuk. mengurangi penggunaan dari crane. Alat 

dilengkapi dengan dongkrak elektrik sebagai pengangkat wheel-set kereta. Sensor 

proximity infrared digunakan untuk mendeteksi jika ada wheel-set kereta yang 

menghalangi saat proses pengangkatan dan pemutaran wheel-set kereta yang akan 

dilepas bearing roda kereta. Mikrokontroler yang digunakan adalah Arduino Uno 

sebagai pemroses hasil deteksi sensor proximity infrared. Kemudian android sebagai 

input data bearing yang disimpan ke database dan pengontrol dongkrak elektrik 

melalui koneksi bluetooth. Realisasi alat fokus pada; (1) instalasi sensor proximity 

infrared ke Arduino Uno, (2) pengujian sensor proximity infrared pada jarak tertentu 

terhadap objek yang dideteksi, (3) pemrograman intruksi pemroses data pada 

mikrokontroler. Indikator sensor mendeteksi adanya wheel-set kereta yaitu LED dan 

buzzer akan aktif.  

 

3.1.1  Perancangan Sistem 

a. Deskripsi Alat  

Nama Alat : Implementasi Sensor Proximity pada Sistem 

Otomasi Pengangkat Roda Kereta Terintgrasi 

Android 

Fungsi Alat : Pengangkat roda kereta dan penyimpan data bearing 

kereta terintgrasi android 
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Nama Sub Alat : Implementasi Proximity sebagai Trigger pada 

Pengangkat Roda Kereta Semi Otomatis 

Berpenggerak Dongkrak Elektrik 

Fungsi Sub Alat : Mendeteksi objek benda yang menghalangi saat 

proses pengangkatan roda kereta sebagai trigger 

pada dongkrak elektrik 

 

b. Cara Kerja Alat 

Teknisi 1: bertugas sebagai peng-input Identitas Bearing dan mengomunikasikan 

Smartphone dengan Alat Pengangkat Roda 

Teknisi 2: bertugas memutar wheel-set kereta dan melepas bearing dari wheel-set 

1. Koneksikan smartphone ke internet  

2. Buka aplikasi DPR (Dibawah Perangkat Roda) pada Smartphone  

3. Input identitas bearing kereta ke aplikasi DPR 

Identitas bearing tersebut terdiri dari nomor, tanggal pembuatan, tanggal masuk 

sesuai dengan Form Isian yang tersedia di UPT Bali Yasa Manggarai 

4. Koneksikan bluetooth smartphone ke modul bluetooth HC-05 agar smartphone 

dapat berfungsi sebagai remote control. 

5. Teknisi 2 memposisikan penyangga dongkrak elektrik di tengah rel. 

6. Teknisi 2 mendorong wheel-set sedemikian rupa sehingga posisinya tepat 

berada di atas penyangga dongkrak elektrik. 

7. Teknisi 2 melepas salah sisi bearing dari wheel-set, 

8. Teknisi 1 menekan dan menahan button up pada aplikasi DPR agar dongkrak 

bergerak naik. 

9. Sensor Proximity Infrared telah diposisikan diantara dua roda  

10. Fungsi sensor Proximity Infrared untuk mendeteksi roda kereta bagian kiri dan 

kanan 

11. Tegangan output sensor Proximity Infrared men-trigger: 
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a. dongkrak elektrik berhenti dan posisi wheel-set berada di atas rel (beberapa 

centimeter) atau memungkinkan dapat diputar. 

b. Bunyi buzzer/LED sebagai indikasi sensor mendeteksi roda kereta 

12. Handle pada DPR di putar teknisi 2 untuk memutar wheel-set sejauh 1800 

13. Teknisi 1 menekan dan menahan button down pada aplikasi DPR, sehingga 

dongkrak bergerak turun 

14. Teknisi 2 melepas bearing sisi lainnya  

15. Selanjutnya Wheel-set di dorong menuju tahap pembubutan roda (bukan topik 

bahasan dalam TA) 

 

c. Spesifikasi alat 

1) Bentuk Fisik 

Fisik alat terdiri dari dongkrak elektrik, dengan bagian bawah diberikan plat 

besi dan bearing. Sensor proximity infrared diletakkan di bagian depan alat dengan 

menggunakan kotak casing yang terbuat dari plat besi (p x l x t = 10 x 10 x 10) cm 

dan bagian belakang alat yang dipasangkan box panel (p x l x t = 30 x 20 x 12) cm 

yang didalamnya terdapat arduino uno, modul driver BTS 7960 dan modul 

bluetooth, sedangkan pada bagian handle alat terdapat tower lamp indicator dimana 

didalamnya sudah terdapat LED dan buzzer. Ukuran keselurahan dari alat ini adalah 

(p x l x t = 75 x 50 x 166) cm. 

 

2) Spesifikasi Hardware 

Tabel 3.1 Spesifikasi Hardware 

Nama Jenis 
Tegangan 

Input (VDC) 

Jumlah 

(Buah) 

Mikrokontroler Arduino UNO ATMega328P  5 - 12 1 

Modul driver BTS 7960 5,5 - 27,5  

Sensor jarak Sharp GP2Y0A02YK0F 3.3 1 

Aktuator Dongkrak Elektrik 12 1 

Indikator 1 LED 5 3 

Indikator 2 Buzzer 5 1 

 

3) Spesifikasi software 
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Program deteksi wheel-set kereta menggunakan software Arduino 

Integrated Development Environment (IDE) dengan bahasa pemrograman C. 

Program yang ditulis menggunakan Arduino IDE disebut sketch. Sketch ditulis 

dalam teks editor dan disimpan dengan ekstensi.ino. Arduino IDE memiliki 

message box yang berfungsi menampilkan error, proses upload program, dan 

compile 

 

d. Blok Diagram 

Blok diagram pada (Gambar 3.1) sebagai acuan untuk merealisasikana alat 

pengangkat roda kereta terintegrasi android. 

Button Up/down 

pada aplikasi 

Smartphone
Arduino UNO

Dongkrak 

Elektrik

Sensor 

Proximity 

Infrared

INPUT PROSES OUTPUT

Buzzer

LED

Modul 

Bluetooth 

HC-05 Modul driver

BTS7960

 

Gambar 3.1. Blok Diagram 

 

Penjelasan tiap blok : 

1. Button Up/down pada aplikasi sebagai remote dongkrak begerak naik/turun 

2. Modul bluetooth HC-05 sebagai komunikasi antara smarphone dan arduino 

3. Sensor Proximity Infrared sebagai pendeteksi wheel-set kereta 

4. Mikrokontroller Arduino Uno mengolah data dari sensor Proximity Infrared 

untuk men-trigger dongkrak elektrik 

5. Modul driver BTS7960 sebagai pengubah arah putaran motor dc pada dongkrak 

elektrik. 

6. Dongkrak elektrik mengatur perpindahan dan pengangkatan wheel-set. 

7. Buzzer sebagai indikator apabila sensor proximity infrared mendeteksi objek  

8. LED sebagai indikator apabila sensor proximity infrared mendeteksi objek 
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3.1.2 Perancangan Program Sistem  

 

a. Deskripsi Program 

Sistem otomasi pengangkat roda kereta terintgrasi android di program dengan 

bahasa C pada software Arduino IDE terinstal board untuk Arduino Uno. 

Pemrograman dirancang berdasarkan penggunaan pin arduino dan sensor. 

Pengalamatan program sistem deteksi wheel-set kereta berdasarkan pin-pin yang 

terpasang pada sensor. Program sensor proximity infrared digabungkan dengan 

program motor DC, hasil deteksi motor diolah untuk men-trigger motor dc pada 

dongkrak elektrik untuk berhenti bekerja. Pemrograman LED dan buzzer untuk 

mengaktifkan indikator saat sistem mendeteksi adanya wheel-set kereta. 

 

b. Cara kerja Program 

Cara kerja program deteksi wheel-set kereta dengan menginisialisasi pin 

input/output sensor. LED pada arduino berkedip ketika program terupload ke arduino. 

Sensor proximity infrared mendeteksi adanya wheel-set kereta. Arduino mengolah data 

analog dari sensor proximity infrared untuk men-trigger motor DC pada dongkrak 

elektrik berhenti bekerja. LED dan buzzer menyala sebagai indikator ketika sensor 

mendeteksi wheel-set kereta atau objek sekitar yang menghalangi proses pelepasan 

bearing roda kereta pada wheel-set kereta. 
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a. Flowchart Sistem 

START

Inisialisasi

Port/Pin Input-Output pada 

Mikrokontroller dengan Sensor, 

modul Bluetooth dan Aktuator

Bluetooth 

terkoneksi?

Adanya objek/

gangguan?

Buzzer, LED 

(merah) aktif 

dan dongkrak 

berhenti naik

YA

TIDAK

Smartphone android 

terkoneksi dengan 

internet

Input data wheel-set 

pada aplikasi android

Smartphone android 

terkoneksi dengan 

modul bluetooth

Simpan hasil data 

input wheel-set 

Database 

wheel-set pada 

web host

Tombol UP pada 

aplikasi Android 

ditekan dan 

ditahan

Dongkrak Elektrik 

bergerak naik  

Tombol UP 

pada aplikasi 

Android dilepas

Dongkrak Elektrik 

berhenti naik  

Sensor Proximity Infrared 

mendeteksi   objek 

Wheel-set diputar 

(180
0
) secara manual

Tombol 

(DOWN) pada 

aplikasi Android 

ditekan dan 

ditahan

Dongkrak Elektrik 

bergerak turun

Adanya objek/

gangguan?

Buzzer, LED 

(merah) aktif 

dan dongkrak 

berhenti turun

Sensor Proximity 

Infrared mendeteksi   

objek 

Tampilan data tabel 

pada aplikasi android

END

A

A

YA

TIDAK

YA

TIDAK

 

Gambar 3.2. Flowchart Sistem 

3.2  Realisasi Alat  

Realisasi alat Sistem otomasi pengangkat roda kereta terintgrasi android 

difokuskan pada sensor proximity infrared. Pembuatan program deteksi wheel-set 
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menggunakan software Arduino IDE. Data hasil deteksi sensor diproses oleh 

mikrokontroler Arduino Uno. 

3.2.1 Wiring Diagram Modul dengan Mikrokontroler 

Pada bagian box panel terdapat mikrokontroler Arduino Uno yang dihubungkan 

dengan modul driver BTS7960 pada pin pwm (D10 dan D11). Dongkrak elektrik 

dihubungkan ke modul driver BTS7960 pada pin W- dan W+ dengan tegangan input 

dari PSU sebesar 12V 30A. Kemudian sensor proximity infrared dihubungkan ke 

mikrokntroler Arduino Uno sebagai pengirim data input untuk diproses di 

mikrokontroler. LED yang digunakan berjumlah 3 buah dengan terhubung pada pin 

digital (D2, D3, D4) dan Buzzer terhubung pada pin digital (D7) pada Arduino Uno. 

Tegangan Input arduino Uno disupply dengan power bank 5A/2A (Gambar 3.3). 

 

 

Gambar 3.3 Wiring Diagram Modul dengan Mikrokontroler 
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Tabel 3.2 Koneksi Pin Modul dan Mikrokontroler 

Arduino Uno  Sensor Sharp GP2Y0A02YK0F 

A0/A1 Signal 

GND GND 

5V VCC 

Arduino Uno BTS7960 

D10 RPWM 

D11 LPWM 

5V R_EN 

5V L_EN 

GND GND 

5V VCC 

Arduino Uno LED 

D2/D3/D4 Anoda (+) 

GND Katoda (-) 

Arduino Uno Buzzer 

D7 VCC 

GND GND 

BTS7960 Motor DC 

M+ M+(Merah) 

M- M-(Hitam) 
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3.2.2 Pemrograman Sistem Deteksi Roda Kereta sebagai trigger Dongkrak 

Elektrik 

 

Buka aplikasi Arduino IDE, pilih “File → New” (Gambar 3.4) untuk membuat 

program baru.  

 

Gambar 3.4 Menu utama Arduino IDE 

 

Setelah semua program diketik pilih Boards Manager pada menu “Tools →Board 

→ Boards Manager”. Pastikan telah tersedia pilihan board untuk Arduino Uno 

(Gambar 3.5). 
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Gambar 3.5 Menu Board pada Arduino IDE 

 

Setelah memilih board Arduino Uno pilih “Tools → Serial Port” (Gambar 3.6) 

untuk memilih port yang terhubung dengan Arduino Uno). 

 

 

Gambar 3.6 Menu Serial Port pada Arduino IDE 
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Upload program Sistem Deteksi roda kereta sebagai trigger dongkrak elektrik setelah 

memilih serial port dengan menekan tanda panah (Gambar 3.7). Tunggu hingga tampil 

tulisan “Done Uploading”. 

 

Gambar 3.7 Menu Upload pada Arduino IDE 

 

Hasil deteksi pantulan cahaya yang diterima receptor pada sensor proximity infrared 

bisa terlihat dengan memilih menu “Tools -> Serial Monitor” (Gambar 3.8). 

 

Gambar 3.8 Hasil Deteksi Sensor 
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3.2.3 Bentuk Fisik Sistem Deteksi Roda Kereta sebagai trigger Dongkrak 

Elektrik 

 

Bentuk fisik didesain dengan menyesuaikan berat dari wheel-set kereta sebesar 

±1,5ton (Gambar 3.9) dengan menggunakan plat besi. Kesalahan desain dan pemilihan 

bahan dapat mengakibatkan Wheel-set tidak dapat terangkat dari atas rel. 

 

Gambar 3.9 Bentuk Fisik Sistem
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BAB V 

KESIMPULAN 

 

 

SIMPULAN 

Dari kegiatan pembuatan alat Tugas Akhir di UPT Balai Yasa Manggarai PT 

Kereta Api Indonesia (Persero) mengalami kendala, akibat pandemic covid-19 

alat/sistem dialihkan dengan pembuatan model pengangkatan, pemutaran, dan 

penurunan wheel-set kereta, karena alat 1:1 terdapat di UPT Balai Yasa Manggarai. 

Pekerjaan/bagian yang belum terselesaikan akan dilanjutkan setelah pembeerlakuan 

PPKM di Jakarta selesai, adapun bagian-bagian yang belum terselesaikan adalah: 

1. Wiring komponen pada alat 

2. Menguji mekanik dan dan elektrik pengangkat, pemutaran dan penurunan wheel-

set kereta dengan beban ± 1.5 ton 

3. Trial and Error pada sistem pengangkat, pemutar dan penurunan wheel-set kereta 

 

Adapun pembuatan/Bagian dan pengujian yang telah dilakukan/diselesaikan adalah: 

1. Desain alat mekanik 1:1 bahan terbuat dari plat besi 

2. Uji coba sensor proximity infrared sebagai trigger pada linear aktuator sebagai 

pemodelan dari dongkrak elektrik 

3. Sensor proximity infrared bekerja dengan mendeteksi ada atau tidaknya objek 

di depannya, semakin jauh benda yang dideteksi sensor maka tegangan output 

sensor yang dihasilkan semakin kecil 

4. Kinerja sensor proximity infrared dipengaruhi juga oleh jumlah intensitas 

cahaya disekitar, semakin besar intensitas cahaya di sekitar maka tegangang 

output sensor semakin kecil.
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LAMPIRAN 2 

 

FOTO ALAT 

 

 
Gambar L.1 Keseluruhan Alat 

 

 
Gambar L.2 Bagian Dalam Alat  
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Gambar L.3 Tampak Atas Alat 

 

 
Gambar L.4 Tampak Samping 

 

  
Gambar L-5 Pengujian cara kerja sensor 

proximity infrared 

Gambar L-6 pengukuran 

intensitas cahaya sekitar 
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Gambar L-7 Gambar keseluruhan alat 1:1 
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LAMPIRAN 3 

 

LISTING PROGRAM  

 

1. Mikrokontroler 1 

//deklarasi pin yang digunakan 

#include <SoftwareSerial.h> 

#define sensorIR A0 

#define sensorIR2 A1//definisi pin analog 

float sensorValue, cm, sensorValue2, cm2;      

#define led1 2 

#define led2 3 

#define led3 4  

 

#define p1 5 

#define p2 6 

#define d1 11 

#define d2 10 

#define buzzer 7 

 

SoftwareSerial bt(8, 9); //8 = RX || 9 = TX 

 

//deklarasi pin sebagai input atau output 

void setup() { 

  Serial.begin(9700); 

  pinMode(sensorIR,INPUT); 

  pinMode(sensorIR2,INPUT); 

  bt.begin(9700); 

  pinMode(led1,OUTPUT); 

  pinMode(led2,OUTPUT); 
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  pinMode(led3,OUTPUT); 

  pinMode(buzzer,OUTPUT); 

  pinMode(p1,OUTPUT); 

  pinMode(p2,OUTPUT); 

  pinMode(d1,OUTPUT); 

  pinMode(d2,OUTPUT); 

   

} 

 

//program utama 

void loop() { 

 

//program koneksi modul bluetooth 

  char dataBt; 

  

 

  if (bt.available()) 

  { 

 

    dataBt = bt.read(); 

 

//rumus analog sensor IR 

sensorValue = analogRead(sensorIR);    //baca data analog  

sensorValue2 = analogRead(sensorIR2);  

cm = 10670.08 * pow(sensorValue,-0.935) - 10; 

cm2 = 10670.08 * pow(sensorValue2,-0.935) - 10;    

 

//program kontrol dongkrak dan motor dari android 

    if ((dataBt == 'a')&&(cm>=70)&&(cm2>=70)) //kiri 
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    { 

     analogWrite (p1, 0); 

     analogWrite (p2, 255); 

     Serial.println("putar ke kanan"); 

     digitalWrite(led1, LOW); 

     digitalWrite(led2, HIGH); 

     digitalWrite(led3, LOW); 

     digitalWrite(buzzer, LOW); 

   

       

      } 

        

    else if ((dataBt == 'b')&&(cm>=70)&&(cm2>=70)) //kanan 

    { 

      analogWrite (p1, 255); 

      analogWrite (p2, 0); 

      digitalWrite(led1, LOW); 

      digitalWrite(led2, HIGH); 

      digitalWrite(led3, LOW);     

      digitalWrite(buzzer, LOW); 

    Serial.println("putar ke kiri"); 

    } 

  

    else if ((dataBt == 'e')) //berhenti1 

    { 

      analogWrite (p1, 0); 

      analogWrite (p2, 0); 

      analogWrite (d1, 0); 

      analogWrite (d2, 0); 
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      digitalWrite(led1, HIGH); 

      digitalWrite(led2, LOW); 

      digitalWrite(led3, LOW); 

      digitalWrite(buzzer, LOW); 

      Serial.println("STOP"); 

    } 

 

    else if ((dataBt == 'c')&&(cm>=70)&&(cm2>=70))//naik 

    { 

      analogWrite (d1, 0); 

      analogWrite (d2, 255); 

      digitalWrite(led1, LOW); 

      digitalWrite(led2, HIGH); 

      digitalWrite(led3, LOW); 

       digitalWrite(buzzer, LOW); 

      Serial.println("dongkrak naik"); 

       

    } 

 

    else if ((dataBt == 'd')&&(cm>=70)&&(cm2>=70)) //turun 

    { 

      analogWrite (d1, 255); 

      analogWrite (d2, 0); 

      digitalWrite(led1, LOW); 

      digitalWrite(led2, HIGH); 

     digitalWrite(led3, LOW); 

      digitalWrite(buzzer, LOW); 

      Serial.println("dongkrak turun"); 

    } 
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    else if (dataBt == 'f' ) //BERHENTI2 

     { 

      analogWrite (p1, 0); 

      analogWrite (p2, 0); 

      analogWrite (d1, 0); 

      analogWrite (d2, 0); 

      digitalWrite(led1, HIGH); 

       digitalWrite(led2, LOW); 

        digitalWrite(led3, LOW); 

        digitalWrite(buzzer, LOW); 

 

    } 

  else if   (!(cm>=70)|| !(cm2>=70) )  //BERHENTI2 

     { 

      analogWrite (p1, 0); 

      analogWrite (p2, 0); 

      analogWrite (d1, 0); 

      analogWrite (d2, 0); 

      digitalWrite(led1, LOW); 

      digitalWrite(led2, LOW); 

      digitalWrite(led3, HIGH); 

      digitalWrite(buzzer, HIGH); 

      Serial.println("ADA OBJEK!"); 

    } 

  } 

   delay(100); 

  } 
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LAMPIRAN 4 

SOP PENGGUNAAN ALAT PENGANGKAT, PEMUTAR, DAN 

PENURUN WHEEL-SET KERETA 

 

Kelistrikan: 

1. Sensor Proximity Infrared  

• Tegangan Input : 5 VDC  

2. Arduino Uno  

• Tegangan Input : 5 VDC 

3. Dongkrak Elektrik  

• Tegangan Input : 12 VDC 
 

Mekanis: 

1. Ukuran model  

a. Ukuran alat 

b. Box panel  

 

: (75 x 50 x 161) cm 

: (30 x 20 x 12) cm 

2. Bahan Kerangka : Plat besi 

 
Tampak Keseluruhan 

 

Fungsi: 

1. Pengangkat, pemutar, penurunan wheel-set kereta semi otomatis 

2. Penyimpan data bearing secara online dengan database 

SOP Pemakaian Alat: 

1. Hubungkan mikrokontroler dengan tegangan 5VDC 

2. Hubungkan modul driver dengan tegangan 12VDC 

3. Nyalakan data internet smartphone android. 

4. Buka aplikasi DPR (Dibawah Perangkat Roda) 

5. Login pada halaman login/ sign up dengan menghubungi admin 

6. Pilih menu bongkar/pasang 

7. Input identitas bearing  

8. Koneksikan bluetooth smartphone dengan bluetooth pada mikrokontroler 

9. Tekan dan tahan tombol UP/DOWN agar dongkrak elektrik bekerja 

naik/turun 

10. Data bearing ditampilkan pada aplikasi DPR 

11. Kembali ke halaman home 
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LAMPIRAN 5 

 

DATASHEET SENSOR SHARP GP2Y0A02YK0F 
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